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Summary

The following information is provided to GE Healthcare Technologies customers in regards to known technical security vulnerabilities associated with Mac-Lab® Hemodynamic,
CardioLab® Electrophysiology, SpecialsLab and ComboLab IT Recording Systems for Cath Lab, EP Lab and other interventional labs as well as the Centricity® Cardiology Data
Management Systems.

Security Patch Base Configuration
The security patch base configuration of the Mac-Lab IT/XT/XTi and CardioLab IT/XT/XTi product at release is listed within the MLCL Base Configuration under the Hemodynamic,
Electrophysiology and Cardiovascular Information Technologies section of the http://www3.gehealthcare.com/en/Support/Invasive Cardiology Product Security website.

Process
The following actions are taken whenever Microsoft/OEMs releases new security patches:
e The Invasive Cardiology Engineering Team performs a security analysis process for supported Mac-Lab IT/XT/XTi, CardioLab IT/XT/XTi, GE Client Review and INW Server
hardware/software.
e If avulnerability meets Mac-Lab IT/XT/XTi and CardioLab IT/XT/XTi validation criteria, the vulnerability is communicated through the GEHC Product Security Database and
Invasive Cardiology Security Website within Three weeks of the patch release.
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e Upon validation of the Mac-Lab IT/XT/XTi and CardioLab IT/XT/XTi vulnerability, the GEHC Product Security Database and Invasive Cardiology Security Website and affected
Mac-Lab IT/XT/XTi and CardioLab IT/XT/XTi Security Patch Installation Instructions are updated.

The Mac-Lab IT/XT/XTi and CardioLab IT/XT/XTi vulnerability validation criteria are as follows: Any vulnerability that allows malware to alter or deny Mac-Lab IT/XT/XTi and CardioLab
IT/XT/XTi functionality and/or infect and propagate through normal system use.

Customers are responsible to stay informed with Microsoft vulnerability notifications and to visit the Invasive Cardiology websites to understand the Mac-Lab IT/XT/XTi and CardioLab
IT/XT/XTi impact. Once a security patch is validated, customers are responsible for the installation of security patches. All Mac-Lab IT/XT/XTi and CardioLab IT/XT/XTi Security Patch
Installation Instructions are available on the Invasive Cardiology Security Website below the Validated Patches table.

Vulnerabilities exposed after the Mac-Lab IT/XT/XTi and CardioLab IT/XT/XTi product release which do not meet the criteria to be validated are not listed within the GEHC Product
Security Database and Invasive Cardiology Security Website. These vulnerabilities are deemed to be non-critical and/or outside normal clinical workflow of the Mac-Lab IT/XT/XTi,
CardioLab IT/XT/XTi and Centricity INW systems and will not be validated. Unlisted patches should not be installed on the products in order to eliminate malfunction and breakdown

risks.
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MLCL v6.9.6 Optional Security Updates

CONTACE INTOTMIATION c.vtieeeeeeteitteeereeeerteeseeestseteesssessssssessssssssssssesssssssssssssessssssesssssssssessasessssssssesssesssesssssstsssssesseessssssssssssessssssesssessssssssessssessessstsessesssesssessssssssesssesssssnes

Revision History

Revision Date Comments
1.0 22 September 2017 e 6.9.6 document separation
e Qualified KB4025341 - July Monthly Rollup
e Added 6.9.6 Installation paths for simplifying patches installation
e September Unqualified Patches
2.0 13 October 2017 e Added instructions to Disable SMB1 Protocol
3.0 27 October 2017 e October Unqualified Patches
4.0 20 November 2017 e Added October Qualified Patches
5.0 11 December 2017 e November Unqualified Patches
6.0 20 December 2017 e For October monthly patch, statement added to uninstall previous monthly patches prior to
installation of October monthly patch on the server
7.0 26 January 2018 e Qualified November and December monthly rollups with other patches. Also added January
Unqualified patches
8.0 9 March 2018 e Added Unqualified February Patch
e Qualified minimum password length changes
e Changed verbiage from “Patch Refresh” to “Patch Updates”
e Further MLCL System Security Recommendation
9.0 20 April 2018 e Added January, February, March and April Qualified Patches
e Updated “Further MLCL Systems Security Recommendations” section and moved the section Optional
Security Updates
10.0 30 April 2018 e Added “"Optionally Remove Abode Reader on INW Server” section to the optional section
e Added Unqualified April Patch
11.0 17 May 2018 e Added May Qualified Patches
e Added .NET patches for versions 3.5 SP1, 4.5.2
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e Added Microsoft Office Patches

12

29 June 2018 e Added Unqualified June Patch

Installation of the Security Patches on MLCL systems
Requirements:
e Updates may be applied at any time other than while the Mac-Lab IT/XT/XTi, CardioLab IT/XT/XTi or SpecialsLab application is open.
e Updates must be re-applied if the system is re-imaged.
Updates apply to both networked and standalone systems.
e Best practice is to update all applicable MLCL systems at the site.

This document applies to 6.9.6R3 only. Please verify that you are running 6.9.6 using the following procedure before proceeding:

s uWNE

Launch the Mac-Lab CardioLab application.

Select Help > About Mac-Lab (or CardioLab, as applicable).
Verify the version number is 6.9.6 Release 3.

Click Close.

Close the application.

Recommendation: Use Internet Explorer (IE) for Catalog download. If you are using the cart feature to download patches, to see the cart it requires opening another tab or new
window for http://catalog.update.microsoft.com

How to Log On to Acquisition and Review Systems

When starting up an Mac-Lab, CardiolLab or SpecialsLab Acquisition or Review system, an auto-logon sequence starts and automatically logs on to the operating system. To install a
security patch, the user must be logged on as micltechuser.

NOTE: Password information is contained within the Security Guide Manual. Otherwise, contact the system administrator or GE Technical Support for current password

information.
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Password information is contained within the Security Guide Manual. Otherwise, contact the system administrator or GE Technical Support for current password information. Logon to

1.
2.
3.
4.
5.
6.
7.
8.

How to Log On to the Centricity Cardiology INW Server

Power on the Acquisition system.

The system boots up to the Custom Shell screen.

Press Ctrl + Action + Del.

Click Logoff. On Windows XP, click Logoff again.

Click OK.

Immediately hold down the Shift key until the login window is displayed.
Log on to the operating system locally as micltechuser.

Log on to the Custom Shell locally as micltechuser.

the INW Server as administrator

How to Log On to MLCL Software Only Systems

Since Software Only systems are supported by the customer, the system needs to be logged into with an administrator account.

How to Install Printer Firmware

The system which will apply the firmware to the printer should be provided by the customer.
NOTE: Mac-Lab CardioLab system should not be used to download and/or apply the Printer Firmware.

Follow the download link in the table

Select the appropriate printer

Select English and the applicable MLCL operating system

Select English and under the Firmware category select the applicable Firmware Update Utility and Click Download
Launch the firmware installer and follow the instructions to complete the firmware update

How to Update Intel Management Engine Firmware (HP Z2440) - HPSBHF03557 Rev. 1
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Logon to the Windows OS and MLCL Custom Shell as micltechuser.

Navigate to the location within the section, MLCL V6.9.6 Patch Updates, which has the Intel Management Engine Firmware Update file sp80050.exe.
Right-click on the sp80050.exe file and select Run as administrator.

Click Yes on the User Account Control dialog box.

Click Next on the InstallShield Wizard.

Accept the agreement and click Next.

Press Y on the command prompt which states “Do you want to update the Management Engine Firmware now [Y/N]?

Reboot the system once the firmware update is completed.

1.
2.
3.
4.
5.
6.
7.
8.

Steps to verify the firmware update was successful:

1. After system reboots, within the HP screen press F10 to enter setup menu.
2. Goto Main > System Information.
3. The ME Firmware Version should be at 9.1.41.3024.

2440 BIOS Update to v2.34 Instructions:

1. Go tothe HP Customer Support - Software and Driver Downloads website:

https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828
Select BIOS.

Select Download for HP Z440/2640/Z840 Workstation System BIOS 2.34 Rev.A.
Log on to the z440 computer as administrator.

Run the downloaded sp80745.exe file.

Select Yes to allow.

Select I accept the terms in the license agreement.

Select View Contents of the HPBIOSUPDREC folder. This opens folder:

O N E W

C:\\swsetup\SP80745\HPBIOSUPDREC
9. Run HPBIOSUPDREC.exe.
10. Select Yes to allow.
11. After several seconds, a log file is created and an install utility window appears. Select Update and Next.
12. Follow the onscreen instructions, select Restart.
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13. The BIOS update will take a few minutes, do not remove power during update. The computer will Reboot twice during this update.
14. After the update, on the first boot screen before Windows launches, verify the BIOS version 2.34 on the bottom left of the screen appears.

ML350 Gen9 BIOS Update to v2.56 Instructions:

1

Go to the HP Customer Support - Software and Driver Downloads website:
https://support.hpe.com/hpsc/swd/public/detail?switemId=MTX_116f29414b06465c96e6bd94ae

SO eNON e NN

Select Download for HP ML350 Gen9 Server BIOS 2.56

Log on to the ML350 Gen9 Server as administrator.

Run the downloaded cp034882.exe file.

Click on Run

Click on Install

Follow the onscreen instructions, select close after installation is complete.
Select Yes to reboot.

The BIOS update will take a few minutes, do not remove power during update.

O After the update, on boot screen before Windows launches, verify the BIOS version 2.56 on the bottom left of the screen appears.

OPTIONAL - How to Install INW Server Performance Enhancement

The following patches do not resolve security vulnerabilities and are optional. These patches may improve network performance. The installation procedure below must be followed

and all listed patches deployed together. This deployment may take up to 12 hours, the large percentage within the KB2775511 installation.

1

Using a non-MLCL system, visit and download the following patches to removable media.

Visit http://catalog.update.microsoft.com/ and enter the below KB numbers to access the patches.
KB2775511 - http://support.microsoft.com/kb/2775511

KB2732673 - http://support.microsoft.com/kb/2732673

KB2728738 - http://support.microsoft.com/kb/2728738

KB2878378 - http://support.microsoft.com/kb/2878378

The following patches are summarized at KB2473205 - https://support.microsoft.com/en-us/kb/2473205
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O O N LB W

-
©

11
12.
13.

KB2535094 - http://support.microsoft.com/kb/2535094 Download at - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=25350948&kbln=en-us
KB2914677 - http://support.microsoft.com/kb/2914677 Download at - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=29146778&kbln=en-us
KB2831013 - http://support.microsoft.com/kb/2831013 Download at - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=2831013&kbln=en-us
KB3000483 - http://support.microsoft.com/kb/3000483 Download at - http://catalog.update.microsoft.com/
KB3080140 - http://support.microsoft.com/kb/3080140 Download at - http://catalog.update.microsoft.com/
KB3044428 - http://support.microsoft.com/kb/3044428 Download at - https://support.microsoft.com/en-us/hotfix/kbhotfix?kbnum=30444288&kbln=en-us

Log on to the INW Server as Administrator.

Insert the removable media and install the patches in the order listed above.

Follow the Microsoft installation instructions to complete the installation of the patches.

Select Windows Start -> Run and enter Regedit and Enter.

In Regedit window, navigate to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\Tcpip

In the dialog Menu, select File -> Export. Name the file MLCLRegSave.reg and place in the C:\Temp directory.

In Regedit windows, from Tcpip navigate to Parameters.

In the dialog Menu, select Edit -> New -> DWORD (32-bit) Value. A new entry is created and name it ‘MaxUserPort'.
Right click on ‘MaxUserPort’, select Modify and enter the value 65534 with a base of Decimal.

Follow the same procedure above and create a new entry named ‘TcpTimedWaitDelay'. Enter the value 60 with a base of Decimal.
Exit the Regedit dialog.

Reboot the INW Server.

OPTIONAL - How to Install Plugin 20007 - Disable SSL V2/V3 - KB187498

PN

6.

7.
Page 9

Log on to Windows as Administrator or a member of that group.

Open a command prompt and enter the following commands:

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Client" /v DisabledByDefault /t
REG_DWORD /d 00000001 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Server" /v DisabledByDefault /t
REG_DWORD /d 00000001 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 2.0\Server" /v Enabled /t REG_DWORD /d
00000000 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 3.0" /f
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8.

10.

11.

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 3.0\Server" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 3.0\Server" /v DisabledByDefault /t
REG_DWORD /d 00000001 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL 3.0\Server" /v Enabled /t REG_DWORD /d
00000000 /f

Close the command prompt.

OPTIONAL - How to Install Plugin 35291 -Weak Hashing

1) Load your security certificate in SQL Server on each ML/CL system in the network (server, acquisitions, reviews and virtual reviews) or the ML/CL standalone acquisition.
2) Disable RDP on each member of the network.

a)
b)
c

My Computer>Properties>Remote settings>Remote
Check “Don’t allow connections to this computer”.
Click ok and reboot.

OPTIONAL - How to Install Plugin 65821 -SSL RC4 Cipher Suites Supported

FUaNE

o w

Log on to Windows as Administrator or a member of that group.

Open a command prompt and enter the following commands:

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 128/128" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 128/128" /v Enabled /t REG_DWORD /d
00000000 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 40/128" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 40/128" /v Enabled /t REG_DWORD /d
00000000 /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 56/128" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Ciphers\RC4 56/128" /v Enabled /t REG_DWORD /d
00000000 /f

Close the command prompt.
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OPTIONAL - How Remove Vulnerability for Plugin 63155 - Microsoft Windows Unquoted Service Path Enumeration

1. Log on to Windows as Administrator or a member of that group
2. Open Regedit do the following
a. On Windows 7
i. Navigate to HKLM\System\CurrentControlset\Services\RtkAudioService
ii. Change the imagepath key value from:
C:\Program Files\Realtek\Audio\HDA\RtkAudioService.exe
To:
“C:\Program Files\Realtek\Audio\HDA\RtkAudioService.exe"
Note: The leading and trailing Quote marks are part of the key value. The quotes are what removes the vulnerability

b. On Windows 2008R2
i. Navigate to HKLM\System\CurrentControlset\Services\Gems Task Scheduler
ii. Change the imagepath key value from:
C:\Program Files (x86)\GE Healthcare\MLCL\Bin\ArchiveUtility\GEMS_TaskSvc.exe
To:
“C:\Program Files (x86)\GE Healthcare\MLCL\Bin\ArchiveUtility\GEMS_TaskSvc.exe"
Note: The leading and trailing Quote marks are part of the key value. The quotes are what removes the vulnerability

OPTIONAL - How to Disable the SMB1 Protocol

Log on to Windows as Administrator or a member of that group.

Open a command prompt and enter the following commands:

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters" /f

REG ADD "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\LanmanServer\Parameters" /v SMB1 /t REG_DWORD /d 00000000 /f
sc.exe config lanmanworkstation depend= bowser/mrxsmb20/nsi

sc.exe config mrxksmb10 start= disabled

OUnkEWNE
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Patch Links

The patches displayed below are qualified on an independent basis and can be installed on a one-by-one basis, although it is recommended that all qualified patches are installed.
There are dependencies within the qualified patch list. In the table below, it is recommended the patches are installed in order from top to bottom to ensure all pre-requisites are met
for all patches. On occasion the patch dependencies require system reboots which are identified in the table below.

NOTE: Due to site configurations, system patch set, qualified patches which have been installed previously or patch dependencies, some patches could fail to install due to the
functionality is already installed. The Microsoft patch installer will alert you to this issue. It this occurs, please continue with the next patch installation.

Alternate Patch locations: In early 2016 Microsoft announced that some patches would no longer be available on the Microsoft Download Center
https://blogs.technet.microsoft.com/msrc/2016/04/29/changes-to-security-update-links/ Therefore, some of the links provided below may not work. Microsoft may move/remove
these links at any time without notice. However, if the links do not work, there are two alternate methods for downloading patches. The first is the Microsoft Catalog
http://catalog.update.microsoft.com . Most fixes not on Microsoft Download Center will be available from the Microsoft Catalog. If a fix is not available from the Microsoft Catalog,
Microsoft has monthly ISO files of the security updates available at https://support.microsoft.com/en-us/kb/913086 To use the ISOs, determine the month of the patch, download the
applicable ISO and extract the patch. If after exhausting all three methods, you are still unable to obtain a patch, please contact GE Technical Support for further assistance.

6.9.6 Installation Paths

There are multiple installation paths depending on the version of 6.9.6 installed and any previous patches which have been installed. The following information will help guide you
through correct installation path

Determine which version of 6.9.6 you are running. This can be done from the Mac Lab/Cardio Lab application. Go to Help/About and you will see the Release number. The release
number combined with the installation scenario will determine the correct path.

Note: The section MLCL Optional Security Updates can be applied after all other patches/updates have been applied. The optional updates provide additional security but are not
required. You may apply some of the optional patches but choose to bypass others. For example, you may want to disable some of the vulnerable protocols by you may not want to
address Weak Hashing due to cost and complexity of certificate management. This will not cause problems. However, all other updates are strongly recommended.
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Some updates are documented as superseded. These are left in the document for completeness but can be skipped.
The following sample scenarios are provided for reference.

(1) New Setup/Reimage a machine for disaster recovery.
(a) For R3 Apply the updates from the following section
() MLCLV6.9.6 2017 Patch Updates 1

(2)  The machine was setup and initially patched but no subsequent updates have been applied.
(a) For R3 Apply the updates from the following section
(i)  No further patches are required. The Patch Updates would have been applied as part of setup

(3)  The machine was setup and all previous patches have been applied

(a) For R3 Apply the updates from the following section
(i) No further patches are required. The Patch Updates would have been applied as part of setup

Unqualified Patches MLCL v6.9.6 R3

INW Server Acquisition - Mac-Lab IT/XT/XTi, GE Client Review Workstation Virtual Review
CardioLab IT/XT/XTi and SpecialsLab

Operating Windows Server 2008 R2 SP1 Windows 7 SP1 Windows 7 SP1 Windows 7 SP1
System
Platform
Current HPSBHF03576 rev. 1 HPESBHF03805 rev.10 HPESBHF03805 rev.10 HPESBHF03805 rev.10
Unqualified KB4284867 (CVE-2018-8225) HPSBHF03576 rev. 1 HPSBHF03576 rev. 1 HPSBHF03576 rev. 1
Vulnerability KB4284867 (CVE-2018-8225) KB4284867 (CVE-2018-8225) KB4284867 (CVE-2018-8225)

MLCL V6.9.6 2017 Patch Updates 1

Windows 7 (Acquisition, Review and Virtual Review)

KB | Link

Notes
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Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

KB2901907

https://www.microsoft.com/en-us/download/details.aspx?id=42642

Right click and Run as
Administrator

Adobe 11.0.20

http://supportdownloads.adobe.com/thankyou.jsp?ftplD=6157&filelD=6191

August Rollup
2017

KB4025341 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=12c93ad9-ef0e-4ce6-8a1d-84713223d24a
July Rollup 2017
KB4034664 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=e0a94bad-5b2¢-4611-9066-24491ce9bb4f To successfully install this

Rollup, you must uninstall
July Rollup KB4025341 and

reboot before installing
KB4034664

Reboot .

Required

KB4019112 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=1daeb6d1-b103-4baa-bbde-5326e17e89e4 Run KB4014514 and
KB4014504 only. For
KB4014514, right click and Run
as Administrator,

KB3125869 https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass- Download and install only the

december-16,-2015 “Enable the User32 exception

handler hardening feature in
Internet Explorer”

KB2889841 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=bb220b30-6d01-4e57-8db6-3e492d6b65d3 .

KB3178688 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=322¢c28f5-349¢c-468a-ac94-901616f52372
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KB3178690 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=06e2c9fb-65b7-48f5-b6e2-58071f17f9bd

KB3178687 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=726adfc6-4ac9-4409-bdab-2892b7058e78

kb3141538 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=6be5e673-e3f6-4c8e-8834-732baf0eb5d3

KB3191847 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4b4bbe2b-a25d-4509-a069-f5efc227b4ad

KB3191907 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c8533f11-51f9-4f84-96d8-c619947cc7c0

KB3118310 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c59a1bb2-ff1f-427a-a8d7-2cablcb3e7dl

KB3191843 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=f715a81d-102d-416a-9a89-e9ebdace0a6d

KB3191899 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7698c63a-b85f-4647-bcb1-1be0256¢3f43

KB3203468 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7a599998-ca41-4840-90ea-8143724e5¢c6a Use all-proof-en-us_.....cab
KB3213624 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3658f96e-a521-429d-a9a9-e70e30f5d830

HPSBHF03557 ftp://ftp.hp.com/pub/softpag/sp80001-80500/sp80050.exe Not applicable for Virtual
Rev. 1 Review.

HP z440 BIOS https://support.hp.com/us-en/drivers/selfservice/hp-z440-workstation/6978828

Update

KB3118378 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=ae54ce3d-e321-4831-alba-fcae8eb430a0
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Make the Following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Windows 2008R2 (INW)

KB

Link

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

Adobe 11.0.20

http://supportdownloads.adobe.com/thankyou.jsp?ftplD=6157&filelD=6191

August Rollup
2017

KB3125869 https://support.microsoft.com/en-us/help/3125869/ms15-124-vulnerability-in-internet-explorer-could-lead-to-aslr-bypass- Download and install only the
december-16,-2015 “Enable the User32 exception

handler hardening feature in
Internet Explorer”

KB4025341 https://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=b2423c5b-0254-4747-88bb-ec1a785549¢cb

July Rollup 2017

Superseded http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=80f7899d-451d-4e3f-b54e-d488a06a3c58 To successfully install this

KB4034664 Rollup, you must uninstall

July Rollup KB4025341 and
reboot before installing
KB4034664
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Reboot

Required

KB4019112 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=dedea6da-e039-487b-8ec6-2729551f7165 Run KB4014514 and
KB4014504 only. For
KB4014514, right click and Run
as Administrator,

HPSBMUO03653 https://h20566. www?2.hpe.com/hpsc/swd/public/detail?switemld=MTX_083799d6dad34195bb47cb4a3cl

rev.l

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\NTDS\Parameters]

LdapEnforceChannelBinding=DWORD:1

Apply only on Domain
Controller

Need starting July Rollup-
KB4025341 (CVE-2017-8563)

MLCL V6.9.6 2017 Patch Updates 2

The following patches bring the MLCL system to a more recent patch level and address several security vulnerabilities. The following guidelines apply:

1) The above patches are required patches for 6.9.6 and must be applied first.
2) ltis expected that some patches listed will already be on the system.

3) Pay attention to the Notes section for special handling instructions

4) Patches must be applied in order except where indicated.

5) Reboots are only required where indicated. If a Patch requests a reboot at another point, the system can be rebooted but it is not required.

6) Patches will not install if the software component to be patched is not present (such as an IE8 patch on a system that does not have IE8 installed).
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Note: KB4041681 replaces KB4041678 for both Windows 7 and Windows Server 2008 R2 to address CVE-2017-11771, CVE-2017-11772, CVE-2017-11780, CVE-
2017-11781

Windows 7 (Acquisition, Review and Virtual Review)

KB Link Notes

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

http://supportdownloads.adobe.com/thankyou.jsp?ftpID=6279&file|D=6314

Adobe 11.0.23

KB4041681 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=8a346e85-6ae3-46aa-a9el-
October 2017 2e70e760f61c

Monthly Rollup

Make the Following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Reboot Required

Windows 2008R2 (INW Server)

KB Link Notes

Make the following Registry Change
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[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

Adobe 11.0.23

http://supportdownloads.adobe.com/thankyou.jsp?ftplD=6279&filelD=6314

KB4041681
October 2017
Monthly Rollup

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=cd0388fd-5aca-4a13-8417-
c28e1d8b7dda

To successfully install this Rollup,
you must uninstall July Rollup
KB4025341,

August Rollup KB4034664 and
reboot before applying
KB4041681

Make the following Registry Change —
Only on

Domain Controller if it does not exist:
[HKEY_LOCAL_MACHINE\System\Curre
ntContro
ISet\Services\NTDS\Parameters]
LdapEnforceChannelBinding=DWORD:1

This registry key is needed on
Domain controller starting July
Rollup- KB4025341 (CVE-2017-
8563)

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000
Reboot Required

MLCL V6.9.6 2018 Patch Updates 3
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The following patches bring the MLCL system to a more recent patch level and address several security vulnerabilities. The following guidelines apply:

1) The above patches are required patches for 6.9.6 and must be applied first.

2) Pay attention to the Notes section for special handling instructions

3) Patches must be applied in order except where indicated.

4) Reboots are only required where indicated. If a Patch requests a reboot at another point, the system can be rebooted but it is not required.

Follow these steps to make the following registry changes to remediate June and September monthly rollup vulnerabilities.
Reference: https://portal.msrc.microsoft.com/en-us/security-quidance/advisory/CVE-2017-8529

Windows 7 (Acquisition, Review and Virtual Review) & Windows 2008R2 (INW Server):

Click Start, click Run, type regedt32 or type regedit, and then click OK.

In Registry Editor, locate the following registry folder: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main\FeatureControl\
Right-click FeatureControl, point to New, and then click Key.

Type FEATURE_ENABLE_PRINT_INFO_DISCLOSURE_FIX, and then press Enter to name the new subkey.

Right-click FEATURE_ENABLE_PRINT_INFO_DISCLOSURE_FIX, point to New, and then click DWORD Value.

Type “iexplore.exe" for the new DWORD value.

Double-click the new DWORD value named iexplore.exe and change the Value data field to 1.

Click OK to close.

O N E W

Windows 2008R2 (INW Server):

Click Start, click Run, type regedt32 or type regedit, and then click OK.

In Registry Editor, locate the following registry folder: HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Internet Explorer\Main\FeatureControl\
Right-click FeatureControl, point to New, and then click Key.

Type FEATURE_ENABLE_PRINT_INFO_DISCLOSURE_FIX, and then press Enter to name the new subkey.

Right-click FEATURE_ENABLE_PRINT_INFO_DISCLOSURE_FIX, point to New, and then click DWORD Value.

Type "iexplore.exe" for the new DWORD value.

Double-click the new DWORD value named iexplore.exe and change the Value data field to 1.

Click OK to close.

NGO FUNE

Windows 7 (Acquisition, Review and Virtual Review)
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Link

Notes

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00023c00

KB4048957
November 2017
Monthly Rollup

KB4054518
December 2017
Monthly Rollup

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=224b07ab-de98-45f0-8b9c-83551cac66f6

Reboot Required

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=5b48d1cb-83f7-43e1-9308-18872ffeddce

Reboot Required

KB3203468 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=7a599998-ca41-4840-90ea-
July 2017 8143724e5cba

Microsoft

Office 2010

KB3213626 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=2bb1487f-b287-41a9-b0ec-
September 01b42aa4759%

2017 Microsoft

Office 2010

KB3128027 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=474aa90a-7767-4f4f-b3f5-
September 2ffal2feadeb

2017 Microsoft

PowerPoint

2010

KB3141537 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=0c646d3e-697d-4463-a6ea-

afb3493c5cea
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September
2017 Microsoft
Publisher 2010

Microsoft Excel
2010

KB2553338 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=14e73852-cbd2-4560-a9a8- Might get error message (The

October 2017 7f0c10f1fa40 upgrade path cannot be installed...)
. This error message can be ignored.

Microsoft

Office 2010 SP2

KB2837599 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=54ccbc02-879e-4aal1-b817-

October 2017 | 12418ce8dfcd

Microsoft

Office 2010 SP2

KB4011612 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=8230d598-8ab1-4efc-89b6- Might get error message (The

December d3507a6dfd20 upgrade path cannot be installed...)

2017 Microsoft This error message can be ignored.

Office 2010 SP2

KB4011660 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d7594745-04d5-4631-b2d7-

January 2018 289816f4dd43

KB4011659 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0b5a1bf0-3043-47fd-afc3-

January 2018 | d2fb55046096

Microsoft

Word 2010

KB4011611 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=3b2c376c-ea57-4925-b81d- Extract to a location and run the
January 2018 3b765d456f2b extraction to install. Check installed
Microsoft updates for a successful install.
Office 2010 SP2

KB4011610 https://www.microsoft.com/en-us/download/details.aspx?id=56447

Page 22 of 34

GE Healthcare/29 June 2018




January 2018

Microsoft
Office 2010
KB4054172 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=537fc3ba-4248-40b8-9498- Install the following KB4054172,
January 2018 8a671abebfe9 KB4019990 and KB4054176
.NET
Framework
KB2719662 Create the following Registry Keys
Key=[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Windows\Sidebar\]
Value Name=[TurnOffSidebar]
Type=[REG_DWORD]
Data=[1]
KB2269637 Create the following Registry Keys

Key=[ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\]
Value Name=[CWDlIllegalinDlISearch]

Type=[REG_DWORD]

Data=[1]

Make the Following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]
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Windows 2008R2 (INW Server)

Service Stack

KB4048957
November 2017
Monthly Rollup

KB4054518
December 2017
Monthly Rollup

Reboot Required
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=435d3006-04ae-4c27-a5f9-3¢c36f09e58ed

Reboot Required
http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=09064e30-6f3e-4c99-8d09-fbc2ba06b436

Reboot Required

KB Link Notes

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software

Publishing]

State=dword:00023c00

http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=f1099598-a22d-4fbe-9b63-09724833acc3 Required for successful Monthly

rollup installation without

KB3177467 uninstalling previous monthly

rollup

KB4054172 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=fdecaf44-5003-4667-0935-
January 2018 | f9e7afObb317

.NET

Framework

KB2269637 Create the following Registry Keys

Key=[ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\]
Value Name=[CWDlIllegalinDlIISearch]

Type=[REG_DWORD]

Data=[1]

Make the Following Registry Change
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[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing]

State=dword:00010000

Reboot Required

MLCL V6.9.6 2018 Patch Updates 4
The following patches bring the MLCL system to a more recent patch level and address several security vulnerabilities. The following guidelines apply:

1) The above patches are required patches for 6.9.6 and must be applied first.

2) Pay attention to the Notes section for special handling instructions

3) Patches must be applied in order except where indicated.

4) Reboots are only required where indicated. If a Patch requests a reboot at another point, the system can be rebooted but it is not required.

Windows 7 (Acquisition, Review and Virtual Review)

KB Link Notes

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust
Providers\Software Publishing]

State=dword:00023c00

KB4056894 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=63bb3909-e5fe-
January 2018 4502-8d59-44f9df52317f

Monthly Rollup

Reboot Required
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KB4091290 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c70372c5-
bd6c-48f7-b562-c326bcl327a4

KB4074598 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=651e95ab-

February 6e7c-4ea6-9cd2-3cbabd9b76f0

Monthly Rollup

Reboot Required

KB4099950 http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0872a60d- CAUTION: This patch has to be applied before
3850-4486-8322-9¢759802017a March Monthly rollup KB4088875. Not applying this
before March rollup can affect NIC settings.
KB4088875 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=3ed75c38-

March Monthly
Rollup

0036-437e-bf4f-574789591e03

Reboot Required

KB4096040 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=be3cdb55-
862c-4362-b015-894e381e07f9

KB4099467 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=f325deb3-
28fc-45a03-ab7b-5264f801daf6
Reboot Required

KB4093118 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=647f49ef-

April Monthly | 0f0a-49dc-9766-dd255cded1af

Rollup

KB4011707 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=969c78ec-
cd6a-4295-ade3-a57ca7f8b3b2

KB3114874 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=9fae99be-

ddc3-4e37-b3ee-9b631fd50eca
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KB3114416 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=da77f81d-
187b-4cae-a75a-d64766a7713d
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=0aa653al- Install AMD64_X86-en-sqlserver2008-kb4057114-
1459-44cd-be0Ob-0fcb77e4ef85 x86_09295f99a2ee7c714f540f3697be0fd4aee7a7bf.exe
Run from a cmd prompt as Administrator using the
following command: AMD64_X86-en-sqlserver2008-
kb4057114-
x86_a9295f99a2ee7c714f540f3697be0fd4aee7a7bf.exe
/ACTION=Patch /INSTANCENAME=MSSQLSERVER
KB4057114 /IGNORESERVICERESTARTSTATE
Reboot Required
KB4103718 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=3f4d0c73-
May 2018 a177-48cf-a3e7-97d1a94cba87

Monthly Rollup

KB4095874
.NET 3.5 SP1
and KB4096495
.NET 4.5.2

KB4022146

Reboot Required

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d000d6a2-

3321-4381-9024-3345b2cd0435

Reboot Required

http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=5795d737-
4091-4784-a707-007b99d3daef

KB4099633 is the KB number to use to download and
install the patch for KB4095874 and KB4096495.
Inside your downloaded file has multiple KBs.
Follow these order of installation:

1) Install KB4019990(You may see already
installed message for this KB, ignore and
continue)

2) KB4095874

3) KB4096495

KB4022146
Microsoft Excel 2010
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Microsoft Excel
2010

KB2899590
Microsoft
Office 2010

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d8acdbaf-
7f56-4c65-0898-9fdfc7a2d83a

KB2899590
Microsoft Office 2010

Make the Following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust
Providers\Software Publishing]

State=dword:00010000

Reboot Required

Windows 2008R2 (INW Server)

KB Link Notes

Make the following Registry Change

[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software

Publishing]

State=dword:00023c00
CP034882 https://support.hpe.com/hpsc/swd/public/detail?switemld=MTX_116f29414b06465c96e6bd94ae
Firmware Refer to “ML350 Gen9 BIOS
Update for Update to v2.56 Instructions”
ML350 Gen 9 section above for installation
Server instructions

Reboot Required
KB4056894 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=fc887fd2-cd35-434b-b6e3-1fef99b2e7ce
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January 2018
Monthly Rollup

Reboot Required

Monthly Rollup

KB4091290 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=c96d43ea-477f-47a1-919f-
6936c8d628ad3

KB4074598 http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=f3ab18cb-219e-4287-b14c-

February 3a05c8d9479a

Reboot Required

Monthly Rollup

KB4099950 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=38b41383-c716-488c-a937- CAUTION: This patch has to be
163bf04f6956 applied before March Monthly
rollup KB4088875. Not applying
this before March rollup can
affect NIC settings.
http://catalog.update.microsoft.com/v7/site/ScopedViewlInline.aspx?updateid=3af42ab1-13ed-42b5-9e4e-
KB4096040 a84la7le7f2c
KB4088875 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=03df6731-e0a6-4917-9da3-
March 161a0b7f6b09

http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=38800bcc-c954-4822-b864-

KB4099467 60e91ccl19bb2
Reboot Required
KB4093118 http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=d2c7363c-323f-4e92-892a-
April Monthly | 90b83027e4aa
Rollup
Reboot Required
http://catalog.update.microsoft.com/v7/site/ScopedViewInline.aspx?updateid=0aa653a1-1459-44cd-belb- Install AMD64-en-sqlserver2008-
Ofcb77e4ef85 kb4057114-
x64_9ce0b7c5909d8fcc5b9al2d1
KB4057114 7f29b7864a9df33a.exe file. Run
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KB4103718
May 2018
Monthly Rollup

Reboot Required
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=4fe75106-02ba-4186-aecd-10424019225e

from a cmd prompt as
Administrator using the following
command: AMD64-en-
sqlserver2008-kb4057114-
x64_9ce0b7c5909d8fcc5b9al12d1
7f29b7864a9df33a.exe
/ACTION=Patch
/INSTANCENAME=MSSQLSERVER
/IGNORESERVICERESTARTSTATE

Reboot Required
http://catalog.update.microsoft.com/v7/site/ScopedViewlnline.aspx?updateid=62ccd808-b5a5-4be9-8a38-
8e20829e29d1

KB4099633 is the KB number to
use to download and install the
patch for KB4095874 and
KB4096495. The downloaded
file has multiple KBs. Follow
these order of installation:
1) Install KB4019990(You
may see already
installed message for

KB4095874 this KB, ignore and
.NET 3.5SP1 continue)
and KB4096495 2) KB4095874
.NET 4.5.2 3) KB4096495
Make the Following Registry Change
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\WinTrust\Trust Providers\Software
Publishing)
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State=dword:00010000

Reboot Required

MLCL v6.9.6 Optional Security Updates

The following optional updates may be applied to further enhance the security profile of the MLCL systems. These updates should be evaluated on a site-by-site basis in
accordance with local IT policy. The configuration changes in this section are compatible with MLCL product functionality but may introduce site specific IT impact as a result
of disabling of legacy SSL protocols, prohibiting remote desktop usage and requiring certificate generation and maintenance.

Additional Security Setting and Patches

INW Server Acquisition - Mac-Lab IT/XT/XTi, GE Client Review Workstation Virtual Review
CardioLab IT/XT/XTi and SpecialsLab
Patch Download URL Download URL Download URL Download URL
MS16-047 https://technet.microsoft.com/library/s | https://technet.microsoft.com/library/s | https://technet.microsoft.com/library/s | https://technet.microsoft.com/library/s
KB3149090 ecurity/MS16-047 ecurity/MS16-047 ecurity/MS16-047 ecurity/MS16-047
Plugin 20007 - | Please see section - How to Install Please see section - How to Install Please see section - How to Install Please see section - How to Install
Disable SSL Plugin 20007 - Disable SSL V2/V3 - Plugin 20007 - Disable SSL V2/V3 - Plugin 20007 - Disable SSL V2/V3 - Plugin 20007 - Disable SSL V2/V3 -
V2/V3 - KB187498 KB187498 KB187498 KB187498
KB187498
Plugin 78479 - | No change needed. Step above fixes No change needed. Step above fixes No change needed. Step above fixes No change needed. Step above fixes
Poodle this. this. this. this.
Plugin 35291 - | Please see section - How to Install Please see section - How to Install Please see section - How to Install Please see section - How to Install
Weak Hashing | Plugin 35291 - Weak Hashing Plugin 35291 - Weak Hashing Plugin 35291 - Weak Hashing Plugin 35291 - Weak Hashing
(Refer to (Refer to (Refer to (Refer to
https://technet.microsoft.com/en- https://technet.microsoft.com/en- https://technet.microsoft.com/en- https://technet.microsoft.com/en-
us/library/ms191192(v=sql.105).aspx | us/library/ms191192(v=sql.105).aspx | us/library/ms191192(v=sql.105).aspx | us/library/ms191192(v=sql.105).aspx
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INW Server

Acquisition - Mac-Lab IT/XT/XTi,
CardioLab IT/XT/XTi and SpecialsLab

GE Client Review Workstation

Virtual Review

for more information)

for more information)

for more information)

for more information)

Plugin 45411 No change needed. Step above fixes No change needed. Step above fixes No change needed. Step above fixes No change needed. Step above fixes
this. this. this. this.

Plugin 65821 - | Please see section - How to Install Please see section - How to Install Please see section - How to Install Please see section - How to Install

SSL RC4 Cipher | Plugin 65821 - SSL RC4 Cipher Suites Plugin 65821 - SSL RC4 Cipher Suites Plugin 65821 - SSL RC4 Cipher Suites Plugin 65821 - SSL RC4 Cipher Suites

Suites Supported (Bar Mitzvah) Supported (Bar Mitzvah) Supported (Bar Mitzvah) Supported (Bar Mitzvah)

Supported (Bar

Mitzvah])

Plugin 63155 - Please see section - How Remove Please see section - How Remove Please see section - How Remove Please see section - How Remove

Microsoft Vulnerability for Plugin 63155 - Vulnerability for Plugin 63155 - Vulnerability for Plugin 63155 - Vulnerability for Plugin 63155 -

Windows Microsoft Windows Unquoted Service | vicrosoft windows Unquoted Service | Microsoft Windows Unquoted Service | Microsoft Windows Unquoted Service

Unquoted Path Enumeration Path Enumeration Path Enumeration Path Enumeration

Service Path
Enumeration

Plugin 59915 - | N/A Please follow the section titled “Disable | Please follow the section titled “Disable | Please follow the section titled “Disable
Vulnerabilities the Sidebar in the system Registry” in | the Sidebar in the system Registry” in | the Sidebar in the system Registry” in
in Gadgets the following Article: the following Article: the following Article:

Could Allow https://technet.microsoft.com/library/s | https://technet.microsoft.com/library/s | https:/technet.microsoft.com/library/s
Remote Code ecurity/2719662 ecurity/2719662 ecurity/2719662

Execution

Disable SMB1 Please see section How to Disable the Please see section How to Disable the Please see section How to Disable the Please see section How to Disable the
Protocol SMB1 Protocol SMB1 Protocol SMB1 Protocol SMB1 Protocol

Password Policy
Password Policy: Minimum Password Length may be changed above the 14 characters limit to meet security requirements. Refer to Password section of the Security
Guide for further details about changing passwords.

Optionally Remove Abode Reader on INW Server
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We recommend that abode reader be uninstalled on the INW Server. On the server Adobe reader is only used to review INW operator manual. The manual is
available in printed format and through online manual portal.

Further MLCL Systems Security Recommendations
We strongly recommend following these recommendations:

Change default password to stronger, more secure and unigue for each user account
Disable RDP in for each system using the following steps:

o My Computer>Properties>Remote settings>Remote

0 Check “Don’t allow connections to this computer”.

0 Click ok and reboot.

If Insite functionality is not used on the system then turn off the VNC service using the following steps:
Click on Start button

Click on Control Panel

Click on Administrative Tools

Double click Services

Right Click TightVNC Server and select Properties

Under Startup type select Disabled from the dropdown

Click on Apply and Ok

o

(0}
(0}
(0}
(0}
(0}
(0}

We also recommend following these general recommendations and the recommendations listed in MLCL Security guide

Enhanced physical security

Network firewalls

Demilitarized Zones and perimeter defenses for site network
Intrusion detection systems - network intrusion protection system
Virtual Private Networks

Network traffic analysis

Log analysis
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Contact Information

If you have any additional questions, please contact our Technical Support Department.
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